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Standards 

The equipment is tested to the following product standards: 

EMC:  EN60945 (2002), EN61000-4-2, EN61000-4-3, EN61000-4-4, EN61000-4-5, 
EN61000-4-6, EN61000-4-11, IEC60092-101 

Environmental: EN60945 (2002), EN60068-2-1, EN60068-2-1, EN60068-2-2, EN60068-2-6, 
EN60068-2-30, EN60068-2-52 

Ingress protection: IEC60529 
Compass safe distance: EN ISO 694 
Health and Safety: EN60950, CSA-C22.2 60950 

For an updated list of approvals and statements of conformity, these are available 

from: www.phontech.net

http://www.jotron.com/
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The information in this book has been carefully checked and is believed to be accurate. However, no 
responsibility is assumed for inaccuracies. 
Zenitel AS reserves the right to make changes without further notice to any products or modules
described herein to improve reliability, function or design. Zenitel AS does not assume any liability
arising out of the application or use of the described product. 

SAFETY INSTRUCTIONS 

This equipment contains CMOS integrated circuits. Observe handling precautions to avoid static 
discharges which may damage these devices. 
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SERVICE AND WARRANTY 
Zenitel warrants that the product sold by Zenitel substantially confirm with said 
products written specifications for a period of up to 24 (twenty-four) months 
after invoice date. Notice of claims shall be made to Zenitel within 30 (thirty) 
calendar days after receipt of the product. The claim must be registered either 
online at www.zenitel.com/customer-service/claims or on RMA form provided 
by Zenitel through claims@zenitel.com.

a) Delivered batteries are generally not covered by Zenitel warranty terms.
b) Buyer also has an option to extend the 24 (twenty-four) (24) months warranty time at a

separate charge. The details for this are found in the valid pricelist, and has to be settled
before delivery of the products.

c) The product must have been properly stored, installed and used to claim under the
warranty.

d) Within the warranty period, the Buyer shall give prompt written notice, if any part of the
product is proven defective in material or workmanship, online either at www.zenitel.com/
customer-service/claims or on RMA form provided by Zenitel through claims@zenitel.com.

e) Zenitel shall not be liable to Buyer or third party claims relevant to accidental or improper
use, wrong installation performed by uncertified technicians, from damage to the product,
or from other circumstances beyond Zenitel’s control.

f) The product shall be returned to Zenitel, subject to prior written consent from Zenitel, in
the form of a RMA reference number (Return Merchandise Authorization). The product
shall be returned immediately, and no later than 60 days after RMA reference number has
been received. Returned products in lack of such reference, will not be accepted by Zenitel
and returned to Buyer at Buyer’s cost.

g) The cost of the return shipment is to be covered by the Buyer. Zenitel will cover the cost of
shipment for replacement parts.

h) Zenitel decides whether a defective part shall be replaced, returned to factory for repair or
being repaired onboard the vessel or on site.

i) If repair/change of parts is to be done onboard the vessel or on site, Zenitel shall approve
by certification the company/technician doing the labor on their behalf.
After the repair is done onboard the vessel or on site, Zenitel will, based on the repair
report, decide if the mentioned repair is a warranty matter or not. If it is a warranty
matter, Zenitel will cover labor time up to 4 hours, and spare parts to correct the fault.
Service technician’s preparation, travelling time and travelling expenses, if any, are for the
account of the Buyer.

j) If Zenitel has to deliver new parts to solve a warranty matter before the claimed product is
received for inspection and acceptance, Zenitel will invoice the new part with standard
order terms at shipment, and then issue a credit note when the defective part has been
received by Zenitel and approved as warranty by quality department.

k) Repair or replacement of parts in a configuration done by Zenitel during the warranty
period, has no effect on the expiration of the warranty for a complete project delivery, and
does not give rise to a renewal or extension of the warranty period for the configuration.
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UTILIZATION: 
This equipment is not to be disposed in normal waste, but be handled in accordance with 
applicable waste disposal regulations in the country where the equipment is used. 

1 SYSTEM DESCRIPTION 

The Integrated Communication System Phontech 6200 is designed to meet the requirements for 
internal communications and shore connections on board ships. 
The system is based on the Phontech 6200 and the Phontech 6200R units. These units are 1U in 
size, and may be combined into a complete scalable system effortlessly.  

The Phontech 6200 units have a built in 2 port fast Ethernet switch for cascading. It supports ring 
network for redundancy. One 1U unit supports up to 24 lines. FXS and FXO, 8 wire E&M and UpN 
(61xx terminals) lines are supported. The units will support a mix of up to 6 line modules with 4 
lines each. Each line is terminated in a RJ45 jack. A typical PABX configuration could be 5 x 4FXS + 
1x4 FXO for a total of 20 telephones and 4 trunks. Typical intercom configuration could be 
4x4UpN + 4FXO + 4E&M. 
A 2x16 LCD character display with switches is provided to view status messages and configure 
basic functions. 

VoIP trunks and terminals are terminated using the Ethernet connection. Up to 50 VoIP (SIP) 
registrations per unit are supported. A number of SIP trunk lines are supported on each of the 
Phontech 6200 units. 
The exchange cabinet is normally located on the ships bridge, or the electronic equipment room. 
The intercom stations may be located in locations requiring two way communications, like the 
engine room, engine control room, mooring stations, generator rooms etc. 

The Phontech 6200 units have been tested and approved according to IEC 60945. 

The Phontech 6200 units are backward compatible with Phontech 61xx terminal hardware. 
Termination can be directly on the front panel using CAT5e type cable and RJ-45 connectors, or 
using 19" patch panels and patch cables. 

If using 6200R, a terminal board (4000019813) is required for easy termination. Less overall rack 
space is used due to not requiring a 19” patch panel.  
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1.1 MAJOR FUNCTIONS 

The major functions of the Phontech 6200 system includes: 

• PABX operation.

• Intercom operation.

• Public address.

• Access to external systems and nets.

• Cost effective modular design.

• Flexible dual power supply configuration.

• Flexible Numbering plan

• Call groups

• Call hunting groups

• Paging groups

• Individual paging

• Intrusion

• Call transfer

• Call forwarding

• Wake up calls

• Who am I / Identification

• Automated switchboard

• Direct Inward Dialing

• Conference bridge

• Configurable access control

• Redundant power supplies

• Self-diagnostic functions

• Field upgradeable hardware and software

• Programmable priority structure.

Various intercom units for all purposes: 

• Office types.

• Flush mounted.

• Weather/ water protected types.

• Noisy area compliant types with extra signal device activation and connection for headset
and loudspeaker.
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1.2 MECHANICAL LAYOUT 6200 

1.3 ELECTRICAL CONNECTIONS 6200 
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1.4 MECHANICAL LAYOUT 6200R 
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1.5 ELECTRICAL CONNECTIONS 6200R 

1.5.1 AC-DC VERSION 

1.5.2 AC-AC VERSION 
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1.6 STACKING 

Multiple Phontech 6200 units communicate using the Ethernet ports LAN1 (25) and LAN2 (26). The 
LAN1 and LAN2 ports are connected internally by a built-in Ethernet switch. Interconnecting 6200 
units is done by connecting Ethernet patch cables between the LAN ports. Three topologies are 
possible. If you have the 6200R, the LAN ports are located at the rear of the unit. 

1.6.1 TREE TOPOLOGY, WHICH IS THE SIMPLEST 

1.6.2 STAR TOPOLOGY, WHICH INCLUDES THE USE OF AN EXTERNAL SWITCH 
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1.6.3 RING TOPOLOGY, WHICH HAS THE ADDED BENEFIT OF REDUNDANCY 

The Ethernet connections have a maximum segment length of 100m. If longer segments are 
required, repeaters or media converters can be used. This allows for physical separation of multiple 
Phontech 6200 units within a single system. 

1.7 RACK MOUNTING 

6200 variant: 
It is recommended to arrange the Phontech 6200 units in pairs with a patch panel in between for 
easy patch cable arrangement. Ports 1-24 on upper 6200 unit will connect to the upper connector 
row on the patch panel, and the lower 6200 to the lower row.  

Allow space for arranging the cables both inside and on the front of the cabinet. 

6200R variant: 
If you are using Phontech 6200R you do not need the patch panel between the units. For 
easy connection, we recommend to use our interface board 4000019813 together with the
6200R. See chapter 3.2.1.3.1 for more information.  



p/n 4000087299 v.J
Page 1-14 

1.8 INSTALLING LINE BOARDS IN THE PHONTECH 6200/6200R 

The line boards are installed on the carrier board inside a Phontech 6200/6200R unit. The line boards 
are color coded. 

Up to 6 line boards can be installed in any order on the carrier board in 6200. 
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Line interface board connectors relates to front panel ports in the following way: 

Line interface board Ports 

1 1 - 4 

2 5 - 8 

3 9 - 12 

4 13 – 16 

5 17 – 20 

6 21 – 24 

Also in 6200R 6 line boards can be installed in any order on the carrier board. 

Line interface board connectors relates to line interface board in the following way: 

Line interface board Ports on interface board 

1 1 - 4 

2 5 - 8 

3 9 - 12 

4 13 – 16 

5 17 – 20 

6 21 – 24 
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1.9 FXS BOARD 

The FXS line board supplies 4 lines of traditional analog telephone lines, aka POTS, Plain Old 
Telephone Service. The FXS line is connected to terminals 4 and 5 on the RJ-45 jack. Parallel 
connection of terminals is possible. 

Line voltage -48VDC 
Ring voltage 50VRms 
Maximum REN 3 
Loop current 25mADC 
Signal levels according to ES 203-021 
Line impedance  according to ES 203-021 

Supported terminals 
Zenitel 5111, 5111-H, 5113, 5123, Gigaset DA710, ResistTel Ex,
FEP-2010 

1.10 FXO BOARD 

The FXO line board supplies 4 trunk lines of the POTS type, Plain Old Telephone Service. This 
interface is the opposite side of the FXS interface, and is typically used to connect to shore lines, 
mobile networks and satellite trunks. 

On-Hook Leakage Current 5uA 
Minimum line DC current 10mA 
Maximum line DC current 60mA 
Ringer equivalence number 0.2 
Ring voltage frequency range 13Hz-68Hz 
Signal levels according to ES 203-021 
Line impedance  according to ES 203-021 

The FXO line is connected to terminal 4 and 5 on the RJ-45 jack 

1.11 UPN BOARD 

The UPN line board supports 4 lines of Zenitel Digital Intercom (61xx) lines.

Line voltage +37VDC
Line impedance 110 ohms 

The UPN line is connected to terminal 4 and 5 on the RJ-45 jack 
The maximum recommended line length is 500m using 0.75 twisted pair ships cable. 
Parallel connection of terminals is not possible. 

Supported Terminals 
Phontech 6110 MkII, 6111, 6112, 6113, 6114, 6123 and 6124 
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1.12 E&M BOARD 

The E&M board is typically used to connect systems like PA/GA and VHF/UHF radio paging. 
It has two audio/key inputs and two audio/key output. 
The audio inputs can be either line level or microphone level with AGC.  The keying input accepts dry 
closing contacts. The audio output is line level with transformer isolation, they key output is a dry 
closing contact. 

Output impedance 150ohms 
Input impedance 4.7kohms 
Nominal line level 0dBu 
Maximum line level +3.15dBu
Nominal mic level -34dBu
Maximum mic level -17dBu
AGC range 44dB

6200 variant: 
The inputs are connected to the upper row of RJ-45 jacks, the outputs to the lower. The keying 
input/output is connected to 3 and 6 on the RJ-45 jack. The audio line is connected to terminal 4 and 
5.
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6200R variant: 
The inputs are connected to odd-numbered ports, while outputs are connected the next even 
numbered port. The audio is connected to lines A/B, while key is connected to lines C/D on the 
4000019813. See chapter 3.2.1.3.1 for more information.

1.13 6200/6200R POWER TERMINAL MODULE 

When the Phontech 6200 or Phontech 6200R is installed in a cabinet, a common power terminal 
module is fitted, for easy termination of the required power supplies, as well as the power failure 
outputs. Power failure outputs are dry closing contacts, and are activated when the corresponding 
power supply fails. 

See chapter 3 for further details. 

1.14 TECHNICAL DATA 

Supply voltages Universal AC input (110-230VAC) 
DC input 24V nominal, 18VDC-72VDC 

Maximum power 
consumption 65W 

Size 445mm x 246mm x 44mm (w, d, h) 
Weight 2.5kg 
Capacity 24 physical lines, 50 registered SIP clients 
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2 INSTALLATION 

2.1 INSTALLATION GUIDE 

The installation should be planned in detail before commencing. The cables should be listed in a 
cable plan, with number of pairs etc. The location of each unit in the communication system should 
be planned to obtain maximum performance and user availability. The locations of the intercom 
stations and telephones with regards to the operators must be taken especially into consideration. 
Zenitel strongly recommend the use of junction boxes for the external cable distribution.

2.1.1 CABLE TERMINATION 
First, ensure that the cable to be used is according to the Zenitel specifications. See 2.1.8 and 2.1.9
for more details. 

2.1.2 GLANDS 
The cables enter weather-proof units by means of cable glands. Where cable glands are not supplied 
from the factory, the installer must adapt the glands to the actual cable outer diameter. This is to 
obtain the specified ingress protection. 

2.1.3 FERRULING 
The conductors should be ferruled prior to termination when using cage clamp terminals. 

2.1.4 MARKING 
Each cable is to be marked with cable numbers. 
Each conductor is to be marked with the specific termination numbers. 
Please note that Zenitel uses plug-able screw terminals in almost all units. This is to make the
installation and service work as easy and durable as possible. 

2.1.5 FASTENING 
Where applicable, the cables and the conductors shall be clamped to the structure with cable ties. 

2.1.6 PRESERVATION 
Prior to, during, and after completion of the installation the equipment surfaces are to be protected 
against acid holding fluids, pollution, moist, impacts etc. This is in order to avoid damaged 
equipment for which Zenitel will claim void warranty.

2.1.7 SCREEN CONNECTION 
In order to obtain maximum performance after installation, it is necessary to terminate the cables 
and ground the screens in a satisfactory manner. The cables are to be de-isolated by removing 
approximately 500mm of the outer insulation. Then the screen braid is cut off approximately 30 mm 
longer than the outer isolation. The conductors are to be de-isolated and ferruled before they are 
inserted into the terminals. The outer screen is clamped to the cable fixing rails inside of the cabinet. 
Cable ties of a conductive type (metal) are recommended for best result. 

2.1.8 CABLE REQUIREMENTS 
All cables used with the Phontech 6200 system must be of approved ship cable type. 

The cables must be: 

• Individually twisted pairs
• Recommended conductor size is 0.75 mm²
• All cabling in the Phontech 6200 system must be a separate network.
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• DO NOT COMBINE DIFFERENT SYSTEMS IN THE SAME CABLE. THIS IS TO PREVENT
DISTURBANCE AND NOISE CAUSED BY INTERFERENCE.

Between the exchange and intercom / telephones: 1 pair.  
If extra signal device / loudspeaker: 1 extra pair for 24 VDC (total 2 pairs) 
Power cables: 1 pair + Ground 

2.1.9 CABLE REQUIREMENTS FOR ETHERNET 
The Ethernet cables must be of specification category 5e UTP or better. Zenitel recommends using
the TIA/EIA-568-B.1-2001 termination scheme. The maximum length of each segment must be 
less than 100m. 

2.1.10 COMPLYING WITH IMO REQUIREMENTS  
The Phontech 6200 system will comply with IMO requirements for two-way voice communication 
systems only if the following is adhered to: 

• Extensions located on the navigation bridge and ECR must have the "Priority access'
checkbox checked. An alternative is for these extensions to be a member of a class where the
'Priority access" checkbox is checked. This will give these extensions the highest priority in
the system.

• When telephones are mounted in close proximity on the above mentioned locations, the ring
tones on adjacent telephones should be selected so that incoming calls are distinguishable.
See the user manual for the respective telephones for information on how to achieve this.

• The Phontech 6200 system must be connected to both mains and emergency power. At least
one of the power inputs must be connected to a power source capable of supplying the
Phontech 6200 system during blackout.
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2.1.11 COMMISSIONING TEST 
The Phontech 6200 shall be configured according to the customer requirement. 

Tests to be performed: 

• Handbook is delivered and available for commissioning

• Check the installation according to installation instructions
Using the configuration as reference, for each extension check: 

• The installed terminal type

• The local extension name and number

• Class membership and priority service

• Group memberships

• If applicable, the hotline extensions

• If applicable, access control

• If applicable PA group memberships

• If applicable Auto answer

For trunk lines: 

• Check trunk type

• Check prefix and DID

• Check access control and billing

2.2 NETWORK RECOMMENDATIONS 

2.2.1 OVERVIEW 
This section describes how the Phontech 6200 system is designed to use an Ethernet network to 
communicate with other Phontech 6200 units, VoIP telephones and VoIP trunks, how to set up the 
Phontech 6200 system in a separate network - either physically or via IEEE 802.1q VLANs as 
supported by many modern switches - and some of the precautions that have to be taken into 
account when using IEEE 802.3af-2003 Power over Ethernet for VoIP telephones. 

2.2.2 PHONTECH 6200 NETWORK CONFIGURATION 
When setting up the Phontech 6200 units, one must first run through the “First Run Wizard” as 
described in Section 2.4.3. The number chosen for the individual 6200/6200R/6202/6202R unit here 
will determine a few things, among these the IP-address the unit will use. By default, all Phontech 
6200 units will use the 172.16.0.0/16 network block, and the unit that has been set up as number 1 
will always run a DHCP server which will serve addresses in the 172.16.1.0 - 172.16.255.254 block to 
clients. The number and IP address of a unit that has already been set up can be viewed via the front 
panel display as described in Section 2.4.4.5.1. 
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In the above example diagram, there are three 6200 units arranged in order, as well as several VoIP 
telephones which receive an IP address from 6200-unit number 1 via DHCP. 

By default, each 6200-unit will route external traffic via 172.16.0.254. Also by default, DNS requests 
will be sent to 172.16.0.254. If an external VoIP trunk is required, please make sure that the router is 
correctly configured to route IP-traffic and to answer DNS requests. 
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We recommend installing the Phontech 6200 system in a physically separate network or in a 
separate 802.1q VLAN. 

2.2.3 INSTALLING THE PHONTECH 6200 IN A SEPARATE NETWORK 
Using a physically separate network is the simplest method of installing a Phontech 6200 system. It 
allows you to isolate the PBX from the rest of your network at the cost of separate infrastructure. 
This is typically the approach taken if there are few to none VoIP telephones or trunks in a Phontech 
6200 system, as there is little need to share infrastructure in these cases. 
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In the above example, three Phontech 6200 units are connected in a redundant ring while being 
separate from the main network. Please note that this also implies separate cabling for the VoIP 
telephones present. 

2.2.4 INSTALLING THE PHONTECH 6200 IN A SEPARATE 802.1Q VLAN 
It is also possible to install the Phontech 6200 system in a network separated by using 802.1q VLANs. 
This method allows you to share infrastructure and cabling that would otherwise have had to be 
duplicated. A VLAN is a virtual LAN that will in effect act as a completely separate network despite 
passing through the same infrastructure and possibly the same cabling; using a VLAN tag to define 
which network the traffic belongs to. It is possible to have up to 4096 different VLANs. Please note 
that in order to use VLANs, you need VLAN-capable infrastructure. 
A common way to organize traffic into VLANs is to separate different independent services into 
separate VLANs. 
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In the example above, traffic is separated into a “Voice VLAN” (with an ID of 50) and a “Data VLAN” 
(with an ID of 60). The “Voice VLAN” is able to use the same infrastructure as the regular “Data 
VLAN” by configuring the switches to tag the traffic appropriately depending on the port it is plugged 
into. This may be configured by making sure that the port the VoIP telephone is placed on has ingress 
tag of 50 and the egress traffic is untagged. Similarly, a computer would have an ingress tag of 60 and 
the egress traffic is untagged. 
It is also possible to allow several VLANs to share one port, by making sure that at least all but one of 
them is tagging egress traffic. In this approach, the end-point must be VLAN-aware in order to 
receive any of the tagged traffic. This could be used to share a port between a computer and a VoIP 
telephone. 

For more complex scenarios, please contact Zenitel for a feasibility study.



p/n 4000087299 v.J
Page 2-26 

2.2.5 USING 802.3AF-2003 POE FOR VOIP TELEPHONES 
Power over Ethernet (“PoE”) allows units which supports it to replace the usual “wall wart” power 
supplies that are commonly used for most electrical products. To take advantage of this, a PoE-
capable switch must be used, the end-point must support PoE and the length of the cabling between 
the two may not exceed 100 meters, as per 802.3af-2003. If cable lengths greater than this is 
desired, please consider distributing one or more switches closer to the end-point, make use of a 
PoE-capable repeater or use a PoE-injector closer to the end-point. 

For PoE, we recommend category 5 cabling or better. 
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2.3 CONFIGURATION APPLICATION 

2.3.1 PREREQUESITES 

2.3.1.1 Requirements 
The Phontech 6200 Configuration Application requires as a minimum the following: 
- Windows Vista SP1, Windows 7, Windows 10 or later.
- At least 1 GHz CPU speed.
- At least 512MiB of RAM.
- At least 500MiB of free disk space.
- 100 Mbit/s Wired Network Connection.
The recommended setup is:
- Windows 7 or later.
- 2Ghz dual-core CPU or better.
- 4GiB of RAM or better.
- 2GiB of free disk space or better.
- 100 Mbit/s Wired Network Connection.

2.3.2 INSTALLATION 
To install the application, run the supplied installer and follow the instructions given. 

2.3.3 STARTING THE APPLICATION 
After installation, the application may be found in the "Start"-menu, as “ICS 6200 Configuration 
Application”.  

Figure 2-1 - Start Menu Entry 
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2.3.4 COMMON TASKS 

2.3.4.1 Connecting to a Phontech 6200 Network 
In order to connect to and configure a Phontech 6200 system, you must connect your computer to 
the Phontech 6200 network. Make sure that your computer is set up to automatically acquire 
network addresses, and connect your computer to one of the LAN ports on the front of the 6200. 
Alternatively, you may connect your computer to the switch used for VoIP telephony if applicable. 

Figure 2-2 - DHCP Settings 

Verify that your computer is connected to the Phontech 6200 network by checking that it has set an 
IP-address. Note that the IP-address shown here is in the 172.16.1.0 – 172.16.255.254 range. 

Figure 2-3 - IP Address 

If you are running Windows Vista, Windows 7 or Window 10, you may receive a dialog asking you 
what kind of network you have connected to. All choices are valid.  
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2.3.4.2 Making Changes and Saving Them 
When making changes to the configuration in the configuration application, it is important to note 
that the changes are not applied to the Phontech 6200 system until you choose to send them. 
Sending your changes can be done via the toolbar, or via "File -> Send". 

Figure 2-4 - Send Configuration 

Figure 2-5 - Send Configuration in File-menu 
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The configuration can also be saved to disk using the regular "Save" or "Save as..." commands. Note 
that this does not imply the "Send" operation - this must be performed separately. 

Figure 2-6 - Save Configuration 

Please note that if you have just set up users on a new Phontech 6200 Unit or a unit that you have 
just installed new line interface boards on, the configuration application will have to perform some 
more intrusive set up procedures, which will cause any ongoing calls on the unit to be terminated. A 
pop-up dialog box will warn you of this before performing this action. 

Figure 2-7 - Required Restart of ICS units 

Once the send operation has succeeded, the configuration application will notify. 

Figure 2-8 - Send OK 

2.3.4.3 First Steps 
Upon successfully connecting to a Phontech 6200 and starting the configuration application, it will 
automatically discover all 6200 units in the network and download the current configuration. 
If the system is newly installed (that is, having just completed the "First Run"-wizard as described in 
the installation guide), an empty configuration is in effect. 
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2.3.4.4 Adding Users 
To add users to the system, please use the Add Multiple Users Wizard. It can be started from the 
start view or from the menu bar under "Users". 

Figure 2-9 - Add Users 

Once you have started the wizard, you will be greeted by an introduction describing the wizard you 
have just started. Continue the wizard by clicking the 'Next'-button. This will lead you to the page 
were you enter the details for the new users. 
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Figure 2-10 - Add Users: Extension, Name, Types and Class membership 

When you create new users you have to enter the extension number, user name and the interface  in 
use by this user. The extension number is the number to call if anyone wants to reach this user. The 
user name is used as a description in the configuration application and will be displayed as the caller 
ID if the dialed phone supports a character display. The interface decides how the phone is 
connected physically and which features the user supports. The different interface alternatives are: 

- Analog (FXS): The "regular" station interface. Requires an unused port on a FXS line interface.
Please note that Analog telephones do not support paging or alert groups.

- Digital (UpN): The Zenitel proprietary digital interface. Requires an unused port on an UpN
line interface.

- Snom 300: The Snom 300 brand VoIP telephone. Allows you to enter a provisioning MAC
address which will be used to automatically configure the telephone. Requires an unused VoIP
license.

- SIP: A generic SIP account which may be used for other VoIP phones. Requires an unused SIP
license.

It is possible, but optional to assign the new user to one or more classes. These can be useful in 
segmenting access to different kinds of features to different sets of users. Classes will be discussed in 
"Managing Users with Classes". 

One or more rows may be added by clicking the green plus icon. The number of rows added is 
determined by the number entered in the input next to the icon. Each new row is automatically 
assigned a new extension number based on the previous row and will inherit the user type and class 
membership of the previous row by default. 
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Given that one or more of the new users are of the FXS or UpN type, you must now choose which 
ports to use. You will be presented with a visual representation of the Phontech 6200 system, where 
you can pick the desired port on the desired unit. The ports to select are determined by the type of 
users you have created. You will be presented with a view of the system once for each technology 
that uses the physical ports. The current interface is described in the upper left corner of the page. 
The right side of the page lists the users that are to be placed in the system. A blue text means that 
this is the user that will be placed with the next click. A gray name means that this user has already 
been placed and a black name signals that this user has not been placed yet. Numbers will be 
displayed on the visual representation to indicate which user has been selected for any placed port. 

Figure 2-11 - Add Users: Port Placement Page 

When placing multiple users, the "Auto Populate" function can be a timesaver. This will automatically 
pick unused ports for you in a sequential fashion. 

If one or more of the new users are of a Snom 300 variant, you must enter the provisioning MAC 
address of the handset. This allows the Phontech 6200 system to automatically provision the 
configuration to the handset once it is connected. 

If you have exceeded all the available licenses for SIP and Snom 300 users you will be notified in the 
bottom of the wizard page and you will not be able to add the users. To add more users of this type, 
please see the licenses section of this manual. 
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Figure 2-12 - Add Users: Adding SIP and Snom 300 Users 

Additionally, if one or more of the new users are of a Snom 300 or SIP type, one may select which 
6200 unit they shall be registered on. The configuration application will automatically select this, 
based on how many VoIP phones are registered on each unit already, but this can be changed here. 
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Figure 2-13 - Add Users: Registration Info for SIP and Snom 300 

2.3.4.5 Managing Users with Classes 

A class is a collection or set of users that may share some properties. It is an optional feature that 
may be used to simplify certain parts of the configuration of large systems. 
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Figure 2-14 - Adding Classes 

Consider a system where a subset of users - let us call them "Officers" – have access to a number of 
features - such as paging groups, dialing out over a trunk interface or high priority access to certain 
users. If we were to add or remove users from this set of Officers, we would have to manually change 
or update the permissions of each of these features - a process which may be error prone or easy to 
forget. This may be simplified by creating an "Officer"-class, which holds all of the relevant users. This 
class would be the only member which had access to the features in question, and the issue of 
adding or removing users from having access to these features is now simply a case of adding or 
removing users from this class. 

By default, the system contains one predefined class, which holds all users. 
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To add classes, please use the "Add Classes Wizard". 

Figure 2-15 - Adding Classes 
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To assign class membership to users, you may use the "User Properties" or "Class Properties" dialogs 
for existing users, or select the desired class when adding new users.  

Figure 2-16 - Adding Members to a Class Using "Class Properties” 
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Figure 2-17 - Assigning Class Membership in the “User Properties” Window 

2.3.4.6 Adding a Group 
Groups provide different functionality on a set of users that are members of the group. The 
functionality differs on the type of group: 
- Call Group: When the group extension is dialed, the group will call all of its members

simultaneously. The member to first pick up the phone will receive the call.
- Call Hunting Group: When the group extension is dialed, the group will dial all of its members

sequentially in a pre-defined order. The first member who picks up the phone will receive the
call.

- Paging Group: When the group extension is dialed, the call will be automatically paged out on
the speakers of the members of the group. This requires paging support on the phones that are
members of the group.

- Alert Group: The alert group allows a sound to be played on the speaker of the members of the
group, based on an external input. This requires an unused E&M input port, as well as paging
support on the phones that are members of the group.
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To add a group, start the relevant group type wizard. 

Figure 2-18 - Adding an Alert Group 

The first step is to enter a name and optionally a description for the group. Unless the group is an 
Alert group, you will also have to enter an extension for the group. If the group is an Alert group, we 
will have to select an unused E&M pair to be used as the source of the alert.  
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Figure 2-19 - Selecting the Input for the Alert Group 

We will then select the members of the group. You may select classes, individual users and, in some 
cases, even other groups. If the group you are adding requires paging functionality, only uses which 
support this is listed. 
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Figure 2-20 - Adding members to the Alert Group. Note that only users which support paging are listed 

Please note that the order of the members is significant in the Call Hunting group, and may be 
adjusted using the arrow buttons. For all other groups, the order of the members is insignificant. 
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Figure 2-21 - Arranging members in a Hunting Group 

Once the members have been added, all we need to do is verify that the information we entered is 
correct. 
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Figure 2-22 - Verifying a new Call Group 

2.3.4.7 Adding a Trunk Line 
A Trunk Line allows you to connect your Phontech 6200 system to another PBX or the public 
telephone system. Different methods may be used to dial out over the trunk or receive calls from the 
trunk. 
The different types of trunks provided are: 
- SIP client: A 6200 unit will register with a remote SIP server and route calls to and from this

server. Requires an unused SIP license.
- SIP server: A 6200 unit will act as a SIP server for a remote client, and route calls to and from this

client. Requires an unused SIP license.
- FXO: Allows you to connect the Phontech 6200 system to an FXS interface of a remote PBX or

what is commonly called PSTN. Requires one or more unused FXO ports.
- E&M Allows you to connect the Phontech 6200 system to an external system providing key and

audio signals. For example, a PAGA system.  Requires an unused input/output pair on an E&M
module.

To add a Trunk Line, start the "Add Trunk Line Wizard". The first step is to enter a name and 
optionally a description for the new Trunk Line. Once this has been completed, we will have to select 
the type of trunk as described above. 
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Figure 2-23 - Adding a Trunk Line 

Figure 2-24 - Selecting the Type of the new Trunk Line 
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If the trunk type is SIP client, you will have to enter the IP-address or hostname of the provider, as 
well as the username, password and realm as supplied by your provider. The 6200 drop down defines 
which 6200 unit in the network the Trunk Line shall be added to. 
The "Behind NAT" checkbox should be checked if the 6200 unit the trunk is added to is behind a 
network address translation layer and must traverse this in order to reach the server. If in doubt, 
leave this checked. If the remote server uses multiple IP-addresses to initiate calls to the 6200 due to 
load balancing, it is possible to resolve all the hostname addresses using the next checkbox. Please 
note that if your provider changes their IP-addresses, you must re-send your configuration to the 
6200 network in order to regenerate the trunk settings. If in doubt, leave this unchecked. 

If the trunk type is a SIP server, you must define the user name, password and realm you have or will 
use on the remote SIP client. You must also select which 6200 unit the client will be registered on. 

If the trunk type is FXO or E&M, you have to select which port(s) to use. You can optionally select 
multiple FXO ports for load balancing. 

Figure 2-25 - Selecting an FXO Port 

The next step is to select what action to take when an incoming call is detected. The Phontech 6200 
can call one or more extensions directly by selecting "Call an extension", give a switchboard-like 
greeting by selecting "Switchboard" or use the supplied number to directly call the intended recipient 
using "Direct Inward Dialing". Alternatively, incoming calls may be disabled. 

Selecting the “Park incoming calls” option when “Call an extension” is selected will change the 
behavior of how the incoming call is dealt with. First a preconfigured phone will ring and answer the 
incoming call. As the call is answered, the system will notify the one who answered the call that a 
parking number has been allocated for the caller. Once the one who answered the call hangs up, the 
caller will be placed in the parking slot announced and another user can dial the configured retrieval 



p/n 4000087299 v.J
Page 2-47 

extension and enter the parking room number to retrieve the call. This extension number is 
configured in the Phontech 6200 System Settings and if it is already configured it will be displayed 
below the checkbox for the parking option. This option can also be changed from the “Incoming Call 
Actions” tab in the Trunk Line properties screen. 

Figure 2-26 - Selecting which action to take upon incoming calls 

Note that the Direct Inward Dialing option is only available for SIP trunk lines. 

Unless incoming calls are disabled, you must select which users and/or groups should be reachable 
through this trunk. Users or groups who are not selected in this step may not be called from the 
trunk, regardless of the selected incoming call action. 
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Figure 2-27 - Select which users who should be reachable from incoming calls 

We must also define the outgoing behavior. This can either be "Prefix and dial out extension" - which 
allows your users to dial out using the trunk with both a prefix and a dial out extension, "Decided by 
extension length" - which sends a call over the trunk line if the dialed number is longer than the 
configured number of digits. "Dial out extension only" - which only provides a dial out extension for 
your users or disabled entirely. Dial out can also be set to "Disabled" if it should not be possible 
under any circumstances to call out with this trunk line. 

It is also possible to enable call logging on a trunk line. For this option to be active you must have a 
6202 Billing Unit connected to your Phontech 6200 network. See more information about this under 
the "Configuring storage" and "Call logging" sections. 
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Figure 2-28 - Outgoing calls behaviour 

Unless dialing out over the trunk is disabled, you must now select the dial out extension, and 
optionally prefix. If "Direct Inward Dialing" was selected during choosing the incoming actions, you 
must now supply your DID-prefix and fallback number in case we do not have a correct prefix to 
send. 
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Figure 2-29 - Supply the extension or prefix number to use 

Finally, please verify that the information is correct. 

Figure 2-30 – Verify trunk settings 
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Many additional settings such as restricting access to dialling out over the trunk, different sounds and 
other tweaks are changeable from the properties page for a trunk line. This is described in chapters 
such as "Access Control", "Call Logging" and "Custom System Sounds". 

2.3.4.8 Printing the Configuration 
In order to get a hard copy of the configuration, you may use the "Print Extension Layout" function. 
This will give you a printout describing the current layout of the configuration, including extension, 
type and port number or MAC address / SIP password. All of this is listed per 6200-unit and grouped 
into physical extensions and VoIP extensions. 

Figure 2-31 - Printing the Configuration 

2.3.4.9 Mark as Good 
If you are happy with the configuration at this point, it is useful to run the "Mark as Good" function 
on the 6200 unit. Please consult the Phontech 6200 Firmware documentation for instructions on how 
to run this function, or how to restore a known good image. 

2.3.5 LESS COMMON TASKS 

2.3.5.1 SIP licenses 
To be able to use SIP telephone or Snom 300 telephones in your Phontech 6200 system, you have to 
have a SIP license installed. This license will be provided to you by Zenitel AS. To check the current
status of your SIP license you can go to the "Help -> Info" item from the menu bar. If you click the 
"Licenses" tab you should see the status of your license. If this tab is grayed out, you do not have any 
license installed. 



p/n 4000087299 v.J
Page 2-52 

Figure 2-32 - License Information 

To acquire a new license from Zenitel AS or upgrade an old one you can use the "Request
License Quote" dialog. This can be found under the "Help -> Request License Quote" menu. 

Figure 2-33 - Request License Quote Menu Item 

Fill out the dialog to request the number of SIP licenses you want and click the "Save" button to get 
a file that contains all this information. Then send this file to cs@zenitel.com and you will be 
instructed on how to proceed with the order. 
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Figure 2-34 - Request License Quote Dialog 

To make sure the license will be correct make sure all Phontech 6200 Units have been connected to 
the system 

When you receive a license file you must import it to the configuration. Be sure to keep this license 
file safe as you will need it again if you want to create a new configuration from scratch for this 
system. Go to the "File -> Import License" menu item and select the license file you were provided. 

Figure 2-35 - Import License 
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If the license file you selected was valid you will be notified about this and you can check the status 
of your license under "Help -> Info" as explained earlier. 

Figure 2-36 - License Import Successful 

2.3.5.2 Access Control 
In order to restrict access to certain resources, it is possible to set up Access Control via the 
configuration application. Access Control means that only a specific predefined set of users may use 
the resource. It is set up using the properties dialog of the resource in question. 

In the dialog, simply set up who should have access to the resource. 

Figure 2-37 - Access Control for a Group 
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Figure 2-38 - Restricting access to a Group 
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Figure 2-39 - Viewing the Access Control settings of a Class 

Figure 2-40 - Restricting Access to a User 
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2.3.5.3 Hotline 
Hotline mode is the ability of having a telephone automatically dial an extension upon going off 
hook. It is possible to set up on analog or digital users by using the properties dialog of the user in 
question and opening the hotline tab. 

Figure 2-41 - Enabling Hotline for a User 

Please note that this means that this user may only reach the recipient(s) specified in the hotline tab 
as he or she may no longer dial extensions. 

2.3.5.4 High Priority Calls 
High Priority Calls is the ability to always be able to reach users regardless if they are already in a 
conversation. This functionality is enabled on a specific user or class. It can be turned on by checking 
the checkbox titled "This user/class can intrude into other users’ calls". Any user with this enabled 
will be able to intrude into other users calls by pressing '1' when queried. Please note that the other 
party will be disconnected. 
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Figure 2-42 - Enabling High Priority for a User 

2.3.5.5 Additional Tools 
The “Tools”-menu of the configuration application contains several additional tools for configuration 
and management of the Phontech ICS 6200/6202 and associated phones. These tools are described 
in the following sections. 

Figure 2-43 – Tools-menu 

2.3.5.1 Modifying Global Snom Settings 
The global Snom settings dialog allows you to change the default settings for all the Snom 300 
telephones in your system. Under "General Options" it is possible to change the default tone scheme, 
clock format and ring tone. In the "Volumes" section you can change the volume on the ringer as well 



p/n 4000087299 v.J
Page 2-59 

as the volumes of calls in speaker and handset mode. Under the "Other" section you can force the 
settings for all phones. This will disallow any user to change any of these settings on the phone itself. 

Figure 2-44 - Changing Global Snom Settings 

2.3.5.2 Modifying Global UpN Settings 
The global UpN settings dialog allows you to change the default settings for the UpN telephones in 
your system. 
It is possible to change the default ring tone, handset volume, speaker volume, paging volume and 
alert volume, as well as setting the default backlight level and the extensions reached by pressing M1 
through M3. 

The speed dial buttons M1 through M3 can operate in different modes, but only when the 
destination extension of a speed dial button is another digital UpN phone. The three modes of 
operations are: 

• Normal - The button works as a normal speed dial. The number is dialed as if it were entered
manually on the key pad.

• Intercom - The number is dialed and the other end automatically goes off-hook in an
intercom state. This means that the sound will go out on the speaker on the other end and
the external microphone will be enabled. The conversation will therefore go both ways until
the call has been terminated.

• Paging - The number is dialed and the other end will go off-hook in speaker mode but the
microphone will not be enabled. This means that the call will only serve as a page that
cannot be responded to without the performing another call.
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All the speed dial buttons can either be pushed once or held down. If the buttons are pushed the 
calls must be terminated by either by putting the handset back on-hook or pressing the ACT key. 
If the buttons are held down the call will automatically terminate once the button is released. 

Figure 2-45 - Changing Global UpN Settings 

2.3.5.1 Custom System Sounds 
The Phontech 6200 system allows you to change some of the default sounds and notifications used 
in the system. To change these sounds you must go to the "Custom Sound Files" screen found under 
the "Tools" menu. 

Before any of the default sounds can be changed you must first upload some new sounds. This is 
done by clicking the "Add" button on the right side of the "Uploaded sound files" list. This will open a 
file dialog where you can select a sound file to upload. The sound file can be either a .wav file or an 
.mp3 file. For the best quality they should be in 8000 Hz Mono. When the file us uploaded it is 
transcoded to the internal format used in the Phontech 6200 system. You can listen to the result of 
the transcode by clicking the newly uploaded file in the list and then click the "Play" button to the 
right of it. 

After one or more files have been uploaded they can be selected in the drop down boxes to the right 
of the page. This will change the sounds in question to the one you have selected. Uploaded sounds 
are also used in other parts of the application such as in the Trunk Line properties screen where you 
can select the sound that will play when a "Switchboard" configuration is used. 
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Figure 2-46 - Custom Sound Files Screen 

2.3.5.2 Modifying Phontech 6200 System Settings 
The Phontech 6200 System Settings dialog allows you to configure certain system-wide features. 
Among these are the “Time”-settings, “SNMP”-settings and the system wide “Analog Phone” 
settings.  

Using this dialog, it is possible to set the time to a specific time zone and to synchronise the time to 
an external NTP-server. This can be useful when you want to synchronise time across multiple 
different systems to avoid that their perception of time drifts between them. “Local time” is the 
default setting, meaning that the system will use its internal clock to keep track of time. The local 
time and date can be set on the Phontech 6200 units using the front panel display. 

It is also possible to set the SNMP settings for the Phontech 6200 system in the tab labelled “SNMP 
Settings”. The system is capable of supporting both version 2 and 3 of the protocol. By default, 
version 2 is enabled. When using SNMP version 2, the community string must be set. By default, this 
is set to “public”. 
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Figure 2-47 - Phontech 6200 System Settings – Time Settings 

Figure 2-48 - Phontech 6200 System Settings - SNMP Settings 
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To enable version 3 of the protocol, simply select the correct version from the dialog and enter the 
desired login information. 
The authentication method, encryption method and security level may be changed from this dialog, 
but the defaults should suffice for most cases. When in doubt, leave this unchanged. 

Figure 2-49 - Setting up SNMP Version 3 

If you wish to receive traps from the Phontech 6200 system, please enable the checkbox and enter a 
valid IP-address, optionally followed by a port. The host entered here will receive traps concerning 
common hardware failures such as power supply failures, fan failures or earth faults. 
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Figure 2-50 - Phontech 6200 System Settings - Analog Phone Settings 

System wide settings for analog phones are configured in the “Analog Phone Settings” tab. Here the 
settings for the “Flash” function can be changed. 

The extension to retrieve calls stored in the incoming trunk line parking lot can be configured from 
the “Trunk Line Parking Settings” tab. Here you can input the extension number that must be called 
to retrieve the stored calls. Once a user dials this number, he or she will be asked to enter the 
parking room number given to the operator who first answered the call. This page will warn if there 
are no trunk lines configured with the parking capabilities or if the selected extension is already in 
use. 
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Figure 2-51 - Phontech 6200 System Settings - Trunk Line Parking Settings 

2.3.5.3 Configuring Billing 
The Phontech 6202 Billing Unit Settings dialog allows you to configure the storage devices in your 
network. This is required to make use of call logging functionality. The dialog can be found under the 
'Tools' menu. 
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Figure 2-52 - Phontech 6202 Billing Unit Settings 

Before any call logging setting can be changed, you must first select a storage unit to be used in the 
network. This is done in the drop down box in the upper left part of the page view. The other settings 
can only be changed after this has been done. 

From this screen you can change the username and password used to access the call logging web 
interface. You can also enable or disable logging of internal calls as well as whether or not to update 
account balances even though balance is not enforced on accounts. This permits accounts to go into 
a negative balance. You can also manage the different PINs used by the system if any trunk lines have 
enabled call logging with PIN authentication. 

To add a new pin, press the green plus icon and a dialog will appear. In this dialog you must enter the 
PIN and optionally a description of the PIN. The description can be changed by selecting the PIN in 
the list and clicking the notebook at next to the green plus icon. If you want to remove a PIN, click it 
and then click the red minus icon. 

If you delete a pin number, the balance attached to this pin will be removed and cannot be restored 
unless you have an earlier backup from the web interface. 
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Figure 2-53 - New PIN Dialog 

The web interface for the storage unit can be access by typing the IP address of the storage unit into 
the address bar of web browser. The address is shown in the drop down where you select the unit to 
use as your call logging storage device. 

2.3.5.4 Call Logging 
If a storage unit has been configured, you can configure call logging on your trunk lines. See the 
"Configuring Billing" section above. 

To configure call logging on a trunk line, right click the trunk line in the left hand tree view and click 
"Properties". This will open the trunk line properties page. Go to the "Outgoing Call Method" tab and 
find the call logging options at the bottom of the page. There are a few different modes of call 
logging that can be enabled and they are as follows: 

• No - This will not enable call logging on this trunk line

• Extension based - This will base call logging and billing on the extension that calls the trunk
line. When a user calls through the trunk line the number he was calling from is logged and
any account balance updates are performed against an automatically created account that
matches the phone that was called from.

• Pin based - A PIN based call logging system will ask the user to input a PIN before he can call
out on a trunk line. When a user dials the trunk line either by a dial out extension or a prefix
or any other method he will be asked for the pin before the call goes out. If the user can
enter a valid PIN, the call will be logged with this PIN number and any account updates will
be to the PIN account that was entered. PIN numbers can be configured in the storage
settings. See the "Configure Storage" section above for more information.
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Figure 2-54 - Trunk Line Properties Screen 

There are two other options that can be enabled in the call logging options page. If "Enable pre-paid 
billing meters" is checked, a user will only be able to make a call if the account he is associated with, 
either a PIN or the phone itself, must have a pre-paid balance. If the required balance is available, the 
call will proceed as normal however it will only be able to run for as long as the user has available 
balance. 

The cost rates for different external extensions can be configured in the storage unit web interface. 

If "Delay billing by 20 seconds" is checked, then the user gets the first 20 seconds of a call for free. 
Depending on the technology that is used to connect the trunk line to the Phontech 6200 system, it 
might be required to tick this to avoid unnecessary billed calls because the user in the other end did 
not pick up. Some systems indicate that they go off-hook before the other end actually has 
answered. 

For more details, see “User manual for Phontech 6200 Call Logging interface” 

2.3.5.1 Migrate Configuration to Another System 
Sometimes it can be useful to use the same configuration on multiple systems. To achieve this, the 
configuration must be migrated from one system to another. We will call the previous system A and 
the new system B. 

The first step is to save the configuration of system A to a file a computer. After the configuration is 
saved the computer must be connected to system B. While the computer is connected to system B, 
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load up the configuration from system A and enter the "Migrate Configuration" wizard from the 
Tools menu. 

In the Migrate Configuration wizard you are presented with the view of the current system as well as 
the view of the system in the loaded configuration. The system in the configuration can be seen 
under "Configured ICSes" (Phontech 6200 units) and the connected system can be found under 
"Unassigned discovered ICSes". The lists in both views display the IP addresses of the units as well as 
the modules that are or have been inserted in them. 

Figure 2-55 - Unassigned ICSes in Migrate Configuration 

If the configured and discovered systems are identical in the module configuration you can press the 
"Auto assign" button found between the two views. This will try to automatically match the modules 
of the configured ICSes and the discovered ones so they map up perfectly. 

If the modules do not match, but you still want to use the configuration anyways you must manually 
assign which discovered ICS in system B that should take over the role of a configured ICS in system 
A. To do this you first click the discovered ICS in the bottom view and then click the configured ICS
you want it to take the role of in the top view and then click the "Assign selected ICS" button to
assign it. The selected discovered ICS should then disappear from the bottom view. Do this for all
configured Phontech 6200 Units.

Only Phontech 6200 units of the same type can be assigned to each other. 
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Figure 2-56 - Assigned ICSes in Migrate Configuration 

Once all configured Phontech 6200 units have been assigned a discovered ICS you can click "Finish" 
to perform the migration. After the migration is done the configuration can be sent to the system as 
normal. 

2.3.5.1 Upgrading Firmware 
It is possible to upgrade the firmware of Phontech 6200 units by using the Phontech 6200 
Configuration Application and a new firmware file as supplied by Zenitel. You can upgrade the
firmware of specific Phontech 6200 units by right clicking on the unit in question in the lower left 
corner of the application and selecting "Upgrade Firmware". However, in cases where you have 
more extensive systems with several 6200 units, it is easier to use the "Update System Firmware" 
dialog, as found under the "Tools"-menu. 

Upon opening either of these two options, you will be asked to find the new firmware file. Once this 
has been done, the application will check that the new firmware is valid and present you with the 
version and build date of both the current firmware and the newly selected firmware. 
If this information looks valid, press "Ok" to send the new firmware to your 6200 unit(s). The 
firmware will be checked for correctness on the Phontech 6200 unit upon receiving it, prior to 
extracting it. The process will take a few minutes and the Phontech 6200 unit(s) will reboot upon 
completing it. 
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Figure 2-57 - Information about Current and New Firmware 

2.3.5.2 Configuring Conference Rooms 
Conference Rooms are special extensions where multiple users may engage in conversations 
together. The Conference Configuration dialog allows you to enable conference rooms and configure 
the extension used to dial to the conference rooms. 

Figure 2-58 - Enabling Conference Rooms 
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2.3.6 TROUBLESHOOTING 

In the case that you run into some trouble, this section contains some pointers on how to get some 
help and how to troubleshoot basic issues. 

2.3.6.1 Starting from Scratch with a New Configuration 
If the configuration you have created does not fit as well as anticipated, it may be easier to restart 
from scratch. This may be done using the "New Configuration" function, which will present you with 
a pristine starting point so you can try again. Remember to send the configuration if you want to 
reset the configuration of the Phontech 6200 network too. 

2.3.6.2 Unable to Send Configuration due to License Error 
If you get the error message below when you try to send the configuration that means that the 
installed license either does not validate or does not provide enough licenses for the amount of SIP 
or Snom 300 phones configured in the system. 

Figure 2-59 - License Error during Send Configuration 

For the license to validate correctly, all of the Phontech 6200 units in the system must be powered 
on and connected to the network. This can be verified by inspecting the list of Phontech 6200 units in 
the lower left corner of the Configuration Application and see that all the status icons are green. 

If the license is not valid for the given system or the number of SIP telephones in use, you can 
request a new license from "Help -> Request License Quote" as explained in the "SIP Licenses" 
chapter. 

2.3.6.3 Revert to Known Good 
If you created a known good fallback previously, it is possible to restore that state by using the front 
panel display of the Phontech 6200 unit. Please consult the Phontech 6200 Firmware documentation 
for instructions on how to perform this operation. 
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2.3.6.4 Factory Reset 
This function will revert the Phontech 6200 unit to its factory state, and remove all configuration, 
databases and settings contained on the Phontech 6200 unit. It is possible to perform this using the 
front panel display of the Phontech 6200 unit. 
Once this has been performed, the Phontech 6200 unit reverts to its factory defaults. This means 
that you will have to run through the first run wizard again. Please consult the Phontech 6200 
Firmware documentation for instructions on how to perform this operation. 

2.3.6.5 Choose Network Interface 

This function can be useful if you have multiple network interfaces connected to different networks. 
This may cause the configuration application to not be able to discover your Phontech 6200 network. 
The dialog present under "Tools -> Network Configuration" allows you manually select the correct 
network interface. By doing this, you will instruct the Phontech 6200 Configuration Application to 
send discovery requests to the correct network instead of the more generic fallback. 
This setting is stored across restarts of the application. The default value is the "Any"-setting. 

Figure 2-60 - Setting a Network Interface 

2.3.6.6 Creating an Information Package 
If you require additional support for your Phontech 6200 System, please enclose an Information 
Package with your support request. The Information Package can be created using the "Help -> Info" 
dialog, simply press the "Export Information" button. This will create a single file containing logs from 
the application and any Phontech 6200 unit in the network, the configurations of each unit and 
information concerning the software versions used for the Configuration Application and each 
Phontech 6200 unit. 
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Figure 2-61 - Information Window 

2.3.6.7 List of allowed separators in names 
It is possible to use alphanumeric characters for names in the configuration application, in addition to 
the following separators: 
- '-' (hyphen)
- ',' (comma)
- '.' (period)
- '+' (plus)
- '&' (ampersand)
- '#' (hash)
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2.4 FRONT PANEL MANUAL 

2.4.1 LED INDICATIONS 

There are three LEDs found on the left side of the Phontech 6200 unit, providing different 
information. From top to bottom, they are the power LED, the info LED and the error LED. 

Figure 2-62 - Phontech 6200 Front View 

The power LED will either be red or green, depending on the power supply status of the unit. If both 
power supplies are active, the LED will be green. If one of the supplies is down, the LED will be red. 
The info LED will show a heartbeat when the unit is running. The frequency of the heartbeat may give 
you an indication of the relative load of the unit. The error LED will light up if an error has been 
detected. More information regarding the type of error can be seen in the Information-menu. 

2.4.2 FRONT PANEL DISPLAY 

The front panel display provides navigation buttons on the left side, an LCD-screen for displaying 
information and a cancel and enter button on the right hand side. The front panel also includes a 
reset button which may be reached by using a safety pin or a similar instrument. 

Figure 2-63 - Phontech 6200 Display and Buttons 

2.4.3 FIRST RUN WIZARD 

Unless the 6200 has been set up previously, it will run a first time setup wizard when powered on. 
This wizard will allow you to set the time and date, as well as choose if the 6200 shall be a new one 
or a replacement for another. 

Figure 2-64 - First Step of the First Run Wizard 

Figure 2-65 - Adjusting Clock and Date in the First Run Wizard 
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Figure 2-66 - Entering the Time in the First Run Wizard 

Figure 2-67 - Entering the Date in the First Run Wizard 

If the 6200 is a new 6200, you must select which number it is. The number shall be unique in a given 
6200 network, and the first 6200 in a given network must be numbered 1. 

Figure 2-68 - Is This a Replacement or a New Unit? 

Figure 2-69 - Select the Number for this Phontech 6200 Unit 

If the 6200 is a replacement for a previous 6200, you may select which 6200 it is a replacement for 
among the ones currently missing. Please note that the replacement 6200 must have the same line 
modules installed. If this is not the case, the wizard will warn you, but you may still complete it and 
reconfigure the unit at your convenience. Once the wizard is completed, the unit will reboot, and can 
be configured and used. 

2.4.4 MENUS 

When running, the display will show the Zenitel logo by default. When this is shown, pressing any
of the buttons on the unit will show the menu system. 

Figure 2-70 - The Zenitel Logo, the Default View

You may navigate through the menu system by using the up and down buttons. Enter will select or 
activate the currently chosen entry, while cancel will go back to the previously selected entry in the 
menu. Use the left and right buttons to select different options found on the same screen. 

The PBX units have all the menus mentioned in these chapters while the Storage units only have the 
“Information” and “Setup” menus described in chapters 2.4.4.5 and 2.4.4.6 respectively. 



p/n 4000087299 v.J
Page 2-77 

2.4.4.1  Module Overview 

Figure 2-71 - Module Overview 

This screen gives a quick overview of the current state of the line modules installed. If any UpN 
modules are installed, it is possible to see which ports on the front that have telephones connected. 

2.4.4.2 Modules 

Figure 2-72 - Modules Menu 

Figure 2-73 - Viewing a Specific Module Position 

This screen gives more in-depth information about each of the line modules installed, such as the 
type of module, the position it is installed in, and which ports on the front correspond to the module 
in question. It is also possible to select individual modules in order to see the extension (if any) that 
have been assigned to that particular port. 

Figure 2-74 - Extension for Port 1 

2.4.4.3 Snom 

Figure 2-75 - Snom Menu 

The Snom menu allows you to see the Snom telephones configured on this Phontech 6200 unit. It 
will show you the extension the Snom telephones are registered under, if the phone has registered 
and the MAC-address of the phone. 

2.4.4.4 SIP 

Figure 2-76 - SIP Menu 
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Figure 2-77 - Viewing a SIP Extension 

The SIP menu allows you to see the SIP telephones configured on this Phontech 6200 unit. It will 
show you the extension the SIP telephones are registered under and if the phone is currently 
registered. 

2.4.4.5 Information 

Figure 2-78 - Information Menu 

The information menu contains different options which allow you to view information concerning 
the current state of this Phontech 6200 unit. 

2.4.4.5.1 Number and IP 

Figure 2-79 - Number and IP Menu 

Figure 2-80 - Viewing the Number and IP of this Phontech 6200 

The number and IP menu will display which 6200 this is and its IP address. 

2.4.4.5.2 Error Information 

Figure 2-81 - Error Information Menu 

Figure 2-82 - Viewing an Error – the Fan Speed is Below the Threshold 

The Error Information menu provides a human-readable explanation of errors found in the system, if 
any. Multiple errors may be displayed and navigated through by using the Up and Down buttons. 
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2.4.4.5.3  Version 

Figure 2-83 - Version Menu 

Figure 2-84 - Viewing the Firmware Version 

The Version menu provides the version and build date of the currently running firmware on this 
Phontech 6200 unit. 

2.4.4.6 Setup 

2.4.4.6.1 Adjust Clock and Date 

Figure 2-85 - Adjust Clock and Date Menu 

Figure 2-86 - Adjust Clock 

Figure 2-87 - Adjust Date 

The Adjust Clock and Date menu allows you to change the time and date on this Phontech 6200 unit. 

2.4.4.6.2 Mark as Good 

Figure 2-88 - Mark as Good Menu 

Figure 2-89 - Selecting the Mark as Good Menu 
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The Mark as Good menu allows you to take a copy of the currently running firmware and 
configuration and store it as a "Known Good" image in a separate part of the unit. This firmware and 
configuration can then be restored using the "Revert to Known Good"-menu at a later date. If you 
choose to create a new "Known Good" image using the "Mark as Good" menu, the 6200 will reboot, 
and make a copy of the firmware and configuration. After this has completed, the 6200 unit will 
reboot into the regular firmware. 

2.4.4.6.3 FXO Tuning 

Figure 2-90 - FXO Tuning Menu 

Note: This sub menu is not available on the Storage units as they do not have any line modules. 

The FXO Tuning menu allows you to automatically tune several parameters related to the FXO 
modules installed in your system. The tuning procedure is designed to help you reduce or eliminate 
unwanted echo that may occur when connecting to other telephony systems. Please note that the 
tuning procedure will cut off ongoing calls on the unit. 
To start the tuning procedure, select the "FXO tuning" option. In order for the tuning procedure to 
work, you must supply a digit which will clear the dial-tone on the unit at the other end. 

Figure 2-91 - Entering a single digit to stop the dial tone 

The tuning procedure will tune each port of every FXO module that is installed in the Phontech 6200 
unit. This process will take a few minutes. After it has completed, the Phontech 6200 unit will reboot, 
and the freshly tuned parameters will be applied. 

Figure 2-92 - Tuning in Progress 

2.4.4.6.4 Factory Reset 

Figure 2-93 - Factory Reset Menu 

Figure 2-94 - Selecting the Factory Reset Menu 

The Factory Reset function allows you to discard all configuration data and settings stored on the 
6200 and restore it to a pristine factory state. Once this has been performed, the Phontech 6200 unit 
will reboot, and present you with the first run setup wizard. 
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2.4.4.6.5 Revert to Known Good 

Figure 2-95 - Revert to Known Good Menu 

Figure 2-96 - Selecting the Revert to Known Good Menu 

The Revert to Known Good function allows you to return to a previously set Known Good checkpoint 
or, if no such point has been created, to the factory defaults. Upon running this function, the 
Phontech 6200 unit will reboot and perform the rollback operation. This will take a few minutes. 
Once this has been completed, the Phontech 6200 unit will reboot again into the Known Good 
checkpoint. A Known Good checkpoint may be restored multiple times. 

2.4.4.6.6 Reboot 

Figure 2-97 - Reboot Menu 

Figure 2-98 - Selecting the Reboot Menu 

The Reboot function allows you to reboot the Phontech 6200 unit. After the Reboot operation, the 
Phontech 6200 unit will return to its regular state.  

2.5 CALL LOGGING WEB INTERFACE 

The Phontech 6200 can be expanded to perform call logging and billing services. For this purpose, the 
Phontech 6202, Billing Unit must be hooked up and configured together with the system. 

This is described in the separate handbook: Users Manual for Phontech 6200 Call logging Interface 
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2.6 PUBLIC ADDRESS IN 6200 

An emergency public address functionality can be set up in a Phontech 6200 configuration. This 
requires an additional power amplifier 1671 (ref. 3.2.1.3.3), a loudspeaker network and two 
Emergency PA units, 6216 (ref. 8.5). 

Figure 2-99 

The two Emergency PA units 6216’s must be connected and configured to a E&M board (ref. ch 1.12 
/ 2.3.4.7) and the termination module (ref ch.1.13). 
The amplifier also requires configuration of an E&M board and the connection set up to the 
termination module. 

2.6.1 ADDING THE AMPLIFIER 1671 TO AN E&M BOARD TRUNK LINE 
Add an E&M trunk line for the amplifier 1671 

Figure 2-100 
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Select E&M line type 

Figure 2-101 

Select E&M port. This port will correspond with specific terminal on the terminal module (ref. ch 
3.2.1.3.1)

Figure 2-102 

Disable incoming calls. Line in level selection is indifferent in this case 

Figure 2-103 
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Select a dial out method. As this extension is only meant to open the interface and access the 
connected amplifier no prefix method is required. 

Figure 2-104 

The system configuration requires a call out extension number. For the Emergency PA functionality, 
no extension is basically required. Select an “fictive” extension number out of the normal range. 

Figure 2-105 

The amplifier 1671 shall be connected to the output port. (ref. ch 3.2.1.3.1) 

2.6.2 PREPARING AN EMERGENCY PA GROUP 
Add an EMPA Group. This function is only available in the toolbar menu. 

Figure 2-106 
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As this EMPA group is intended to be accessed by Emergency PA unit 6216 only, no extension is 
basically required. Select an “fictive” extension number out of the normal range. 

Figure 2-107 

Add the previously prepared Trunk line; “Amplifier 1671 Connection” as a member of this EMPA 
group. 

Figure 2-108 
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2.6.3 ADDING A 6216 TO AN E&M BOARD TRUNK LINE AND ACCESS TO THE EMPA 
GROUP 

Add an E&M trunk line for the 6216 

Figure 2-109 

Select E&M line type 

Figure 2-110 

Select E&M port. This port will correspond with specific terminal on the terminal module (ref. ch 
3.2.1.3.1) 

Figure 2-111 
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Select “Call an extension” and “Microphone Mode” 

Figure 2-112 

Add the previously prepared EMPA group “Emergency Public Address announcement” as the 
incoming call action for this trunk line. 

Figure 2-113 
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Then at last disable incoming call as this is not an option for the Emergency PA Unit. 

Figure 2-114 

Any more 6216, Emergency PA units is added to access this “Emergency Public Address 
announcement” group. 

AN EMPA GROUP HAS AN OVERALL PRIORITY IN THE SYSTEM AND WILL OVERRIDE ANY 
OTHER ACTIONS. 
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2.7 PHONTECH 6200 AS PA/GA SPEAKER LOOP 

The Phontech 6200 system can be configured as a speaker loop for an existing PA/GA system such as 
MPA 1600. The alarm and PA messages will be administered from the PA/GA system and the phones 
in the Phontech 6200 system will be used as a speaker loop where the alarm or message will be 
played. This requires an E&M connection between the Phontech 6200 and the PA/GA system as well 
as telephones in the Phontech 61xx, 62xx or 72xx ranges. The messages from the PA/GA system will 
always take priority if configured as outlined in this chapter. 

Note: Telephone stations in priority areas cannot be used as a speaker loop because they must 
remain available for two way communication in the event of a PA or GA event. 

The PAGA systems audio output should be connected to the Phontech 6200 E&M input and a closing 
contact for PA and GA events on the PAGA side should be connected to the same E&M input port 
(ref. ch 1.12) and (ref. ch 3.2.1.3.1). 

2.7.1 CREATE EMPA GROUP FOR TELEPHONE STATIONS 
Create the EMPA group that will be used when distributing the PA/GA alarms and messages. This can 
be done by clicking the ‘Groups’ menu and selecting ‘Add EMPA Group’. 

Figure 2-115: Create EMPA group 

Enter a name and select an unused extension number for it. 

Figure 2-116: Enter group information 
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Select the recipients of PA/GA messages and alarms. Note that only Phontech 61xx, 62xx and 72xx 
stations are supported and high priority stations are not listed in the available list.  
NOTE: An EMPA group has an overall priority in the system and will override any other actions, so 
don’t select stations that should be usable during a PA/GA event. 

Figure 2-117: Select group members 

Complete the wizard and locate the newly created group in the left hand extension list. Double click 
on it or right click and select ‘Properties’. 

Figure 2-118: Locate the new EMPA group 

From the opened properties screen, select the ‘Skip Ding Dong before message’ checkbox to avoid a 
duplicate ding dong when the PA/GA system already generates one. Click the Save button in the 
bottom right to apply the changes and proceed to configure the PA/GA trunk line. 

Figure 2-119: Disable Phontech 6200 generated Ding Dong 
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2.7.2 ADDING THE TRUNK LINE CONNECTED TO THE PA/GA SYSTEM 
Add an E&M trunk line for the PA/GA system, detailed information can be found in (ref ch 2.3.4.7). 

Figure 2-120: Adding a trunk line to the PA/GA system 

Select E&M line type. 

Figure 2-121: Select line type 

Select E&M port. This port will correspond with specific terminal on the terminal module (ref. ch 
3.2.1.3.1)

Figure 2-122: Select E&M port 
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Set Incoming action to Call an extension and select Line In Mode as EM Input Mode. 

Figure 2-123: Select incoming call action 

Select the group created in (ref ch 2.7.1) as the incoming call handler for the trunk line. 

Figure 2-124: Select incoming destination 

Disable the outgoing actions for this trunk line. Alternatively, a Dial Out Extension can be selected if 
telephone stations should be allowed to send PA messages through the E&M interface and to the 
PAGA system. This requires additional wiring of the E&M output as described in (ref ch 1.12) and (ref 
ch 3.2.1.3.1). 
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Figure 2-125: Disable outgoing actions 

The setup should now be complete and the configuration should be sent to the Phontech 6200 units 
by pressing the ‘Send Configuration’ button in the main screen. 
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3 SYSTEM CABINETS/RACKS AND TYPICAL CONFIGURATIONS 

3.1 CONFIGURATIONS FOR 6200 
The basic cabinets for the Phontech 6200, ICS system configurations are a range of 4 different mini 
rack sizes; 9U (4000018934ICS), 16U (4000019835ICS), 25U (4000018936ICS) and 34U
(4000018937ICS). A 34U combination rack for ICS and PAGA is also available (4000018937COM).
All cabinets/racks are based on the Schroff Novastar series, colour RAL7021 BlackGrey. All racks are 
floor/desk mounted with cable entry from the bottom. 
Each cabinet comes in either a AC primary / DC backup (AC/DC) or AC primary / AC backup (AC/AC) 
power selection. 

3.1.1 18934ICS, 9U PHONTECH SYSTEM CABINET 

This 9U cabinet has a flexible configuration. Specific Layout drawings are available upon request 
within the standard configurations. Each layout is further configurable within each Phontech 6200 
module (24L (FXS/FXO/UpN/E&M) and 48IP (VoiP registrations): 

Drawing No.: Sequence No: Max configuration 

14848-001-ML -01 72L / -IP 

-“- -02 48L / -IP 

-“- -03 24L / -IP 

-“- -04 48L / 24IP 

-“- -05 24L / 48IP 

-“- -06 24L / 24IP 

-“- -07 -L / 48IP

-“- -08 -L / 24IP

Layout example (14848-001-ML-01), 3 pcs 6200; 72 Lines, 0 VoIP. 
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Layout example (14848-001-ML-04), 2 pcs 6200, 1 LAN Sw; 48 Lines, 24 VoIP. 

Layout example (14848-001-ML-07) 1 pc 6200; 0 Lines, 48 VoIP. 
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Terminal arrangement and connection 

AC/DC (14848-001-TA-01 / 14848-001-EC-01): 

AC/AC (14848-001-TA-02 / 14848-001-EC-02): 
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For further connection details each system is supplied with a project dependent cable plan. This is 
during production filled in with factory defaults and may be added further installation specific cable 
details. See chapter 3.3 for details. 
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3.1.2 4000018935ICS, 16U PHONTECH SYSTEM CABINET 

This 16U cabinet has a flexible configuration. Specific Layout drawings are available upon request 
within the standard configurations. Each layout is further configurable within each Phontech 6200 
module (24L (FXS/FXO/UpN/E&M) and 48IP (VoiP registrations): 

Drawing No.: Sequence 
No: 

Max 
configuration 

Drawing No.: Sequence 
No: 

Max 
configuration 

14848-004-ML -01 144L / -IP 14848-004-ML -14 48L / 72IP 

-“- -02 120L / -IP -“- -15 48L / 48IP 

-“- -03 96L / -IP -“- -16 48L / 24IP 

-“- -04 72L / -IP -“- -17 24L / 96IP 

-“- -05 48L / -IP -“- -18 24L / 72IP 

-“- -06 24L / -IP -“- -19 24L / 48IP 

-“- -07 120L / 24IP -“- -20 24L / 24IP 

-“- -08 96L / 48IP -“- -21 -L / 120IP

-“- -09 96L / 24IP -“- -22 -L / 96IP

-“- -10 72L / 72IP -“- -23 -L / 72IP

-“- -11 72L / 48IP -“- -24 -L / 48IP

-“- -12 72L / 24IP -“- -25 -L / 24IP

-“- -13 48L / 96IP 

Layout example (14848-004-ML-01), 6 pcs 6200; 144 Lines, 0 VoIP. 

Layout example (14848-004-ML-10), 3 pcs 6200, 3 Lan Sw; 72 Lines, 72 VoIP. 
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Layout example (14848-004-ML-21), 3 pcs 6200, 5 Lan Sw; 0 Lines, 120 VoIP. 
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Terminal arrangement and connection 

AC/DC (14848-004-TA-01 / 14848-004-EC-01): 
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AC/AC (14848-004-TA-02 / 14848-004-EC-02): 

For further connection details each system is supplied with a project dependent cable plan. This is 
during production filled in with factory defaults and may be added further installation specific cable 
details. See chapter 3.3 for details. 
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3.1.3 18936ICS, 25U PHONTECH SYSTEM CABINET 

This 25U cabinet has a flexible configuration. Specific Layout drawings are available upon request 
within the standard configurations. Each layout is further configurable within each Phontech 6200 
module (24L (FXS/FXO/UpN/E&M) and 48IP (VoiP registrations): 

Drawing No.: Sequence 
No: 

Max 
configuration 

Drawing No.: Sequence 
No: 

Max 
configuration 

14848-007-ML -01 240L / -IP 14848-007-ML -29 72L / 120IP 

-“- -02 216L / -IP -“- -30 72L / 96IP 

-“- -03 192L / -IP -“- -31 72L / 72IP 

-“- -04 168L / -IP -“- -32 72L / 48IP 

-“- -05 144L / -IP -“- -33 72L / 24IP 

-“- -06 120L / -IP -“- -34 48L / 168IP 

-“- -07 96L / -IP -“- -35 48L / 144IP 

-“- -08 72L / -IP -“- -36 48L / 120IP 

-“- -09 48L / -IP -“- -37 48L / 96IP 

-“- -10 24L / -IP -“- -38 48L / 72IP 

-“- -11 24L / -IP -“- -39 48L / 48IP 

-“- -12 192L / 24IP -“- -40 48L / 24IP 

-“- -13 168L / 48IP -“- -41 24L / 168IP 

-“- -14 168L / 24IP -“- -42 24L / 144IP 

-“- -15 144L / 72IP -“- -43 24L / 120IP 

-“- -16 144L / 48IP -“- -44 24L / 96IP 

-“- -17 144L / 24IP -“- -45 24L / 72IP 

-“- -18 120L / 96IP -“- -46 24L / 48IP 

-“- -19 120L / 72IP -“- -47 24L / 24IP 

-“- -20 120L / 48IP -“- -48 -L / 192IP

-“- -21 120L / 24IP -“- -49 -L / 168IP

-“- -22 96L / 144IP -“- -50 -L / 144IP

-“- -23 96L / 120IP -“- -51 -L / 120IP

-“- -24 96L / 96IP -“- -52 -L / 96IP

-“- -25 96L / 72IP -“- -53 -L / 72IP

-“- -26 96L / 48IP -“- -54 -L / 48IP

-“- -27 96L / 24IP -“- -55 -L / 24IP

-“- -28 72L / 144IP 
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Layout example (14848-007-ML-01), 10 pcs 6200; 240 Lines, 0 VoIP. 

Layout example (14848-007-ML-18), 5 pcs 6200, 4 Lan Sw; 120 Lines, 96 VoIP. 
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Layout example (14848-007-ML-48), 4 pcs 6200, 8 Lan Sw; 0 Lines, 192 VoIP. 

Terminal arrangement and connection 

AC/DC (14848-007-TA-01 / 14848-007-EC-01): See documents 14848-007-TA-01 and 14848-007-EC-
01 
AC/AC (14848-007-TA-02 / 14848-007-EC-02): See documents 14848-007-TA-02 and 14848-007-EC-
02 
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For further connection details each system is supplied with a project dependent cable plan. This is 
during production filled in with factory defaults and may be added further installation specific cable 
details. See chapter 3.3 for details. 
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3.1.4 18937ICS, 34U PHONTECH SYSTEM CABINET 
This 34U cabinet has a flexible configuration. Specific Layout drawings are available upon request 
within the standard configurations. Each layout is further configurable within each Phontech 6200 
module (24L (FXS/FXO/UpN/E&M) and 48IP (VoiP registrations): 

Drawing No.: Sequence 
No: 

Max 
configuration 

Drawing No.: Sequence 
No: 

Max 
configuration 

14848-007-ML -01 312L / -IP 14848-007-ML -50 96L / 192IP 

-“- -02 288L / -IP -“- -51 96L / 168IP 

-“- -03 264L / -IP -“- -52 96L / 144IP 

-“- -04 240L / -IP -“- -53 96L / 120IP 

-“- -05 216L / -IP -“- -54 96L / 96IP 

-“- -06 192L / -IP -“- -55 96L / 72IP 

-“- -07 168L / -IP -“- -56 96L / 48IP 

-“- -08 144L / -IP -“- -57 96L / 24IP 

-“- -09 120L / -IP -“- -58 72L / 216IP 

-“- -10 96L / -IP -“- -59 72L / 192IP 

-“- -11 72L / -IP -“- -60 72L / 168IP 

-“- -12 48L / -IP -“- -61 72L / 144IP 

-“- -13 24L / -IP -“- -62 72L / 120IP 

-“- -14 288L / 24IP -“- -63 72L / 96IP 

-“- -15 264L / 48IP -“- -64 72L / 72IP 

-“- -16 264L / 24IP -“- -65 72L / 48IP 

-“- -17 240L / 72IP -“- -66 72L / 24IP 

-“- -18 240L / 48IP -“- -67 48L / 240IP 

-“- -19 240L / 24IP -“- -68 48L / 216IP 

-“- -20 216L / 96IP -“- -69 48L / 192IP 

-“- -21 216L / 72IP -“- -70 48L / 168IP 

-“- -22 216L / 48IP -“- -71 48L / 144IP 

-“- -23 216L / 24IP -“- -72 48L / 120IP 

-“- -24 192L / 120IP -“- -73 48L / 96IP 

-“- -25 192L / 96IP -“- -74 48L / 72IP 

-“- -26 192L / 72IP -“- -75 48L / 48IP 

-“- -27 192L / 48IP -“- -76 48L / 24IP 

-“- -28 192L / 24IP -“- -77 24L / 240IP 

-“- -29 168L / 144IP -“- -78 24L / 216IP 

-“- -30 168L / 120IP -“- -79 24L / 192IP 

-“- -31 168L / 96IP -“- -80 24L / 168IP 

-“- -32 168L / 72IP -“- -81 24L / 144IP 

-“- -33 168L / 48IP -“- -82 24L / 120IP 

-“- -34 168L / 24IP -“- -83 24L / 96IP 

-“- -35 144L / 168IP -“- -84 24L / 72IP 

-“- -36 144L / 144IP -“- -85 24L / 48IP 

-“- -37 144L / 120IP -“- -86 24L / 24IP 

-“- -38 144L / 96IP -“- -87 -L / 264IP

-“- -39 144L / 72IP -“- -88 -L / 240IP

-“- -40 144L / 48IP -“- -89 -L / 216IP
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Drawing No.: Sequence 
No: 

Max 
configuration 

Drawing No.: Sequence 
No: 

Max 
configuration 

14848-007-ML -41 144L / 24IP 14848-007-ML -90 -L / 192IP

-“- -42 120L / 192IP -“- -91 -L / 168IP

-“- -43 120L / 168IP -“- -92 -L / 144IP

-“- -44 120L / 144IP -“- -93 -L / 120IP

-“- -45 120L / 120IP -“- -94 -L / 96IP

-“- -46 120L / 96IP -“- -95 -L / 72IP

-“- -47 120L / 72IP -“- -96 -L / 48IP

-“- -48 120L / 48IP -“- -97 -L / 24IP

-“- -49 120L / 24IP 
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Layout example (14848-010-ML-01), 13 pcs 6200; 312 Lines, 0 VoIP. 
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Layout example (14848-010-ML-35), 6 pcs 6200, 7 Lan Sw; 144 Lines, 168 VoIP. 
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Layout example (14848-010-ML-87), 6 pcs 6200, 11 Lan Sw; 0 Lines, 264 VoIP. 

Terminal arrangement and connection 
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AC/DC (14848-010-TA-01 / 14848-010-EC-01): See documents 14848-010-TA-01 and 14848-010-EC-
01 
AC/AC (14848-010-TA-02 / 14848-010-EC-02): See documents 14848-010-TA-02 and 14848-010-EC-
02 

For further connection details each system is supplied with a project dependent cable plan. This is 
during production filled in with factory defaults and may be added further installation specific cable 
details. See chapter 3.3 for details. 

3.1.5 15U PABX/PA/GA COMBINATION ENCLOSURE 
Three-part 15U wall-mounted enclosure.  When combining the PABX with PA/GA equipment or amplifiers 
this enclosure style is used. Solid top and cable entry brush insert at bottom. 
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3.1.6 18937COM, 34U PHONTECH SYSTEM CABINET 
This 34U cabinet is a dual functionality cabinet where one half contains the flexible configuration of 
the 16U cabinet 4000018935ICS (see chapter 3.1.2). The other half contains an MPA1600 PAGA
system of up to 1440W output power into 6 zones. See MPA 1600 system documentation handbook 
for details. 
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3.2 CONFIGURATIONS FOR 6200R 

3.2.1 X-100278C, PHONTECH COMPACT CABINET 

This 5U cabinet has a flexible configuration. Specific Layout drawings are available upon request 
within the standard configurations. Each layout is further configurable within each Phontech 6200R 
module (24L (FXS/FXO/UpN/E&M) and 23IP (VoiP registrations): 

Drawing No.: Sequence No: Max configuration 

100278C-ML -01 72L / -IP 

-“- -02 48L / 23IP 

It’s also possible to add Amplifier 1671 for PA-functionality and/or a Billing Unit 6202R in the 
Compact Cabinet. 

3.2.1.1 Layout example (100278C-ML-01), 3 pcs 6200R; 72 Lines, 0 VoIP 

3.2.1.2 Layout example (100278C-ML-02), 2 pcs 6200R; 48 Lines, 23 VoIP 
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3.2.1.3 Terminal arrangement and connection 

3.2.1.3.1 6200R Interface board  
For easy connection, we recommend to use the 4000019813 interface board.

Interface board x-19813: 
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FXS, FXO and UpN line board: 

Port (x) – Line:  A and B (C and D not in use) 

E/M line board: 
The inputs are connected to odd-numbered ports, while outputs are connected the next even 
numbered port. The audio is connected to lines A/B, while key is connected to lines C/D. 

Port 1 – Audio in: A and B 
 Key In: C and D 

Port 2 – Audio out: A and B 
 Key out: C and D 
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3.2.1.3.2 Power/Service/Loudspeaker Terminals 

3.2.1.3.3 1671 Amplifier - Electrical connection 
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3.2.1.3.4 6202R Billing Unit - Electrical connection 

3.2.1.3.5 7200 PoE Lan Switch - Electrical connection 

Interface board 4000019812

Termination: 
Port (x) 1- White/Orange 

2- Orange
3- White/Green
4- Blue
5- White/Blue
6- Green
7- White/Brown
8- Brown
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3.3 PROJECT DEPENDANT CABLE PLAN 

Together will all new Phontech 6200 systems, a USB memory stick is attached. This contains all 
necessary handbooks together with a project dependent Cable plan. 
FXS/UpN/FXO/E&M Cable detail plan: 

And so on. 
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VoIP Cable detail plan: 

And so on. 
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4 INTERCOM UNITS 

4.1 FIRST GENERATION INTERCOM UNITS 
6111 6112 6113 6114 6123 6124 

4.1.1 GENERAL CONFIGURATION INFORMATION 

All intercom units (Phontech 6111, 6112, 6113, 6114, 6123 and 6124) are equipped with an internal 
DIP-Switch block containing 8 switches. These configure some individual settings for each unit: 

DIP Sw Description 

1 Activate Backlight DIMMER function in the Phontech 6123 

2 For future use 

3 For future use 

4 Disable OFF HOOK sensor (ACT key is the only way to activate the unit) 

5 For future use 

6 For future use 

7 For future use 

8 For future use 
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4.1.2 PHONTECH 6110 MKII, ACCOMODATION UNIT 

- Built- in WP loudspeaker.
- Hands free, duplex communication.
- Privacy switch.
- Telecom standard alphanumeric keypad.
- Manual PTT (push-to-talk) key.
- ACT key. (line active)
- 3 direct access programmable keys. (M1-M2-M3)
- 10 pcs. accessible programmable keys. (0-9)
- Volume control key (VOL) with override (important message priority)
- Program key. (P)
- Connection: One Pair – line feed
- Desk or bulkhead mounted.

Operation voltage 37VDC provided by line 
Current drain 70 mA max, provided by line 
Sound pressure level 80dBA@1m typical 
Weight 1.0 kg 

External connections Phontech 6110 MkII 
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4.1.3 PHONTECH 6111, WP UNIT WITH HANDSET 

- Bulkhead mounted.
- Output for external loudspeaker.
- Hands free (requiring external loudspeaker), duplex communication.
- Telecom standard alphanumeric keypad.
- Rugged handset of WP type.
- Manual PTT (push-to-talk) key.
- ACT key. (line active)
- Direct access programmable keys. (M1-M2-M3)
- 10 pcs. accessible programmable keys. (0-9)
- Volume control key (VOL) with override (important message priority)
- Program key. (P)
- Call signal relay. (For external signal organ, flashlight, siren etc.)
- Connection:

o Handset only: One Pair – line feed connection
o External loudspeaker or relay for external signal device: Line + 24V DC
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Operation voltage 37VDC provided by line 
Current drain 70 mA max, provided by line 

External loudspeaker and relay function requires an additional power input. 
Power requirement, additional input 
1A/24VDC 
External loudspeaker: 
Max power 10W 

Impedance 20 ohms 

External signal organ current capabilities: 
24 VDC: max. 5A 
115 VAC: max. 6,3A 
220 VAC: max. 5A 

Weight   1.0 kg. 
Ingress protection IP 56 

4.1.4 PHONTECH 6112 WEATHERPROOF UNIT 
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- Bulkhead mounted.
- For external loudspeaker.
- Hands free (requiring external loudspeaker), duplex communication.
- Telecom standard alphanumeric keypad.
- Manual PTT (push-to-talk) key.
- ACT key. (line active)
- Three direct access programmable keys. (M1-M2-M3)
- 10 accessible programmable keys. (0-9)
- Volume control key (VOL) with override (important message priority)
- Program key. (P)
- Call signal relay. (For external signal organ, flashlight, siren etc.)
- Connection:

o Line
o 24V DC

Operation voltage 37VDC provided by line 
Current drain 70 mA max, provided by line 

External loudspeaker and relay function requires an additional power input. 
Power requirement, additional input 
1A/24VDC 
External loudspeaker: 
Max power 10W 

Impedance 20 ohms 

External signal organ current capabilities: 
24 VDC: max. 5A 
115 VAC: max. 6,3A 
220 VAC: max. 5A 

Weight   1.0 kg. 
Ingress protection IP 56 
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External connections Phontech 6111/6112 
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4.1.5 PHONTECH 6113 AND 6123 FLUSHMOUNTING UNIT 

- Flush-mounting.
- Built-in WP loudspeaker.
- Output for external loudspeaker.
- Hands free, duplex communication.
- Telecom standard alphanumeric keypad.
- Manual PTT (push-to-talk) key.
- ACT key. (line active)
- Three direct access programmable keys. (M1-M2-M3)
- 10 accessible programmable keys. (0-9)
- Volume control key (VOL) with override (important message priority)
- Program key. (P)
- Call signal relay. (for external signal organ, flashlight, siren etc.)
- Phontech 6123 only; backlighting with dimmer.
- Connections:

o Handset only: One Pair – line feed connection
o External loudspeaker or relay for external signal device: Line + 24V DC
o Phontech 6123 Backlight: Line + 24V DC

Operation voltage 37VDC provided by line 
Current drain 70 mA max, provided by line 
Sound pressure level 80dBA@1m typical 
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Backlight dimmer 5 steps : 10mLux – 1 Lux 

External loudspeaker and relay function requires an additional power input. 
Power requirement, additional input 
1A/24VDC 
External loudspeaker: 
Max power 10W 

Impedance 20 ohms 

External signal organ current capabilities: 
24 VDC: max. 5A 
115 VAC: max. 6,3A 
220 VAC: max. 5A 

Weight   1.5 kg. 
Ingress protection IP 44 

External connections Phontech 6113/6123 
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4.1.6 PHONTECH 6114 WP PORTABLE UNIT 

- Built-in WP loudspeaker.
- Internal microphone.
- Duplex communication.
- Telecom standard alphanumeric keypad.
- 10 m. cable and connector.
- Manual PTT (push-to-talk) key.
- ACT key. (line active)
- Three direct access programmable keys. (M1-M2-M3)
- 10 accessible programmable keys. (0-9)
- Volume control key (VOL) with override (important message priority)
- Program key. (P)
- Connection: Pluggable one pair – line feed
- Bulkhead mounting.

Operation voltage 37VDC provided by line 
Current drain  70 mA max, provided by line 

Weight  1.5 kg. 
Ingress protection IP 56 
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4.1.7 PHONTECH 6124 WP BULKHEAD UNIT 

- Built-in WP loudspeaker.
- Internal microphone.
- Duplex communication.
- Telecom standard alphanumeric keypad.
- 10 m. cable and connector.
- Manual PTT (push-to-talk) key.
- ACT key. (line active)
- Three direct access programmable keys. (M1-M2-M3)
- 10 accessible programmable keys. (0-9)
- Volume control key (VOL) with override (important message priority)
- Program key. (P)
- Connection: Pluggable one pair – line feed
- Bulkhead mounting

Operation voltage 37VDC provided by line 
Current drain  70 mA max, provided by line 

Weight  1.5 kg. 
Ingress protection IP 56 
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4.1.8 TYPE 9011 PLUGBOX (FOR PHONTECH 6114) 

- Receptacle with cover.
- Rugged plastic box.
- Bulkhead mounting

Weight 0.3 Kg 
Ingress protection IP 56 
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External connections Phontech 6114 and 9011 
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4.2 SECOND GENERATION INTERCOM UNITS 
6210 6211 6212 6223 7210 7211 7212 7223 

4.2.1 PHONTECH 6210, ACCOMODATION UNIT, TWO WIRE 
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4.2.2 PHONTECH 6211, WP UNIT W/HANDSET, TWO WIRE 
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4.2.3 PHONTECH 6212, WP UNIT WO/HANDSET, TWO WIRE 
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4.2.4 PHONTECH 6223, CONSOLE MOUNTED UNIT, TWO WIRE 
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CONSOLE UNMOUNTING INSTRUCTIONS 
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4.2.5 PHONTECH 7210, ACCOMODATION UNIT, VOIP 
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4.2.6 PHONTECH 7211, WP UNIT W/HANDSET, VOIP 
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4.2.7 PHONTECH 7212, WP UNIT WO/HANDSET, VOIP 
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4.2.8 PHONTECH 7223, CONSOLE MOUNTED UNIT, VOIP 
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CONSOLE UNMOUNTING INSTRUCTIONS 
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4.3 TYPE 6035 HEADSET WITH HOOKSWITCH 

For use with 5111-H, 6112, 6211, 6212, 6223, 7211, 7212 and 7223 

- High comfort headset with boom microphone and hook-switch.
- Excellent attenuation at low and high frequencies with maximum comfort for continuous

use.
- Ideal in severe noise environments.
- Folds to compact size for easy storage.
- 10 m. cable. (optional 15m)
- Noise cancelling microphone.
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5 ANALOG TELEPHONES 

5.1 GIGASET DA710 

- Dimensions (approx.):
o 221 x 202 x 62 mm (LxWxD)

- Weight:  0.9 Kg
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5.2 PHONTECH 5113/5123 FLUSHMOUNTING TELEPHONE 

- DTMF analogue telephone
- Loudspeaking/handset operation
- 3 Speed dial keys
- Relay for external signal device Max 5A
- Ext. loudspeaker connection
- Console flush mounting
- IEC 60945 Approved
- 5123 only: Backlight /dimmer control 

Weight: 1.2 Kg 
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5.3 PHONTECH 5111 RUGGED INDUSTRIAL TYPE TELEPHONE 

- Housing: Polycarbonate / Colour: Black
- Handset retaining mechanism
- Protection degree: IP65/IEC 529
- Receiver volume can be boosted by 6 or 12 dB(A)
- Ringer output: approx. 96 dB(A) at 1 m distance
- Temperature range: -25°C up to +60°C
- Desktop or bulkhead mounting

Weight: 1.7 Kg 
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5.4 PHONTECH 5111-H RUGGED INDUSTRIAL TYPE TELEPHONE WITH 
HEADSET INTERFACE 

- Housing: Polycarbonate / Colour: Black
- Handset retaining mechanism
- Protection degree: IP65/IEC 529
- Receiver volume can be boosted by 6 or 12 dB(A)
- Ringer output: approx. 96 dB(A) at 1 m distance
- Temperature range: -25°C up to +60°C
- Desktop or bulkhead mounting
- Connection for 6035 headset
- 24VDC power supply required

Weight: 1.7 Kg 
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5.5 EX RESISTTEL TELEPHONE FOR HAZARDOUS AREAS 

Bulkhead mounting 
- Types of protection:

o II 2 G EEx em[ib] IIC T5 / II 2 D IP66 T100°C / -25°C<=Ta<=60°C
o II 2 G EEx em[ib] IIC T6 / II 2 D IP66 T80°C / -25°C<=Ta<=40°C

- Housing Glass fibre reinforced polyester
- Certified for dust and gas atmospheres
- Display 2 lines; alphanumerical / multiple languages
- Telephone directory
- Hands free operation
- Impact protection IK 09
- Integrated adjustable stabilizer bracket
- Operations temperature -25°C to +60°C
- Adjustable receiver volume (7 steps)
- Max audio level approx. 90 dB(A)
- Stainless steel (V4A) keypad and steel armored handset cord with snap-protection

Weight: 5.7 Kg 
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6 IP TELEPHONES 

6.1 SNOM 300 

Basic office IP telephone 
- Two line display
- Caller ID (Name / Number)
- Programmable function keys
- Hands free operation
- 2 Eth ports (internal switch)
- PoE / External supply
- SIP Client
- Headset connection

- Intercom operation

Weight: 1.0 Kg 
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6.2 SNOM 710 

Basic office IP telephone 
- Backlit graphical display, 4 lines
- Dual-angle footstand: 46° and 28°
- Wall mountable
- Hands-free talking (speakerphone)
- Digital Signal Processor (DSP) enhanced audio quality
- 2-port 10/100 Mbps Ethernet switch (RJ45)
- Power over Ethernet IEEE 802.3af, Class 1
- Electronic Hook Switch (EHS) support for wireless headsets
- Intercom operation

Dimensions (approx.): 
o 205 x 185 x 40 mm (LxWxD) w/o footstand
o 205 x 185 x 200/220 mm (LxWxD) with footstand

Weight:  0.6 Kg 
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6.3 FERNTEL IP 

Industrial Phone for Indoor and Outdoor Environments, IP 65 
- Display
- Caller ID (Name / Number)
- Caller ID (Name / Number)
- SIP client
- Desk / Wall mounting
- PoE / External supply

- Optional: available as Ex approved type (Zone 2/22)

Dimensions (approx.): 293 x 191 x 128 mm (HxWxD) 
Weight:  2.3 Kg 
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6.4 RESISTTEL IP2 

Industrial Phone for Indoor and Outdoor Environments, IP 66 
- Display
- SIP client
- Hands free operation
- 2 Eth ports (internal switch)
- Desk / Wall mounting
- PoE / External supply
- Optional Relay output

Dimensions (approx.): 293 x 227 x 135 mm (HxWxD) 
Weight:  5.0 Kg 
Temperature: -40°C to + 70°C
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7 NETWORKING EQUIPMENT 

7.1 PHONTECH 7200 

The Phontech 7200 LAN switch includes 24 Gb Ethernet and 2Gb SFP ports for fiber connectivity. 26 

ports in total. The switch is fully manageable through the Web and Command line interface. 

- 24 Ethernet ports
- 2 SFP Gb ports
- PoE, 24 ports
- Dual power supply
- IEC 60945 approved

Weight:  3.9 Kg 
Temperature: -15°C to + 55°C
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7.2 SF-300 

24 port Ethernet switch with PoE 

The SF-300 Ethernet switch with Power over Ethernet is required for the connection of IP telephones. 
Connect the IP telephones to the SF-300 switch using Cat5e patch panels. The SF-300 is in turn 
connected to the Phontech 6200’s Ethernet connection. Power is supplied from the switch to the IP 
telephones over the Ethernet cable. 
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8 ACCESSORIES 

8.1 50 PORT TELEPHONY PATCH PANEL 

The 50 port Cat3 patch panel can be used when connecting FXS, FXO, UPN and E&M lines to the 
Phontech 6200 when structured cabling is used in the installation. This drawer style patch panel 
allows for easy access during termination of the field cable. 

8.2 24 PORT CAT5E PATCH PANEL 

The 24 port Cat5e patch panel is intended to be used for Ethernet lines, but may also be used for FXS, 
FXO, UPN and E&M lines. 
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8.3 6205 48 PORT PATCH PANEL FOR SHIPS CABLE. 

The Phontech 6200 is primarily designed for use with structured cabling. When using traditional ships 
cable, the 6205 patch panel is used together with the termination module. The patch panel is 
connected to the termination module using a 25 pin DSUB cable. 
. 

Electrical connections
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8.4 Y-CABLE FOR 6205 PATCH PANEL 

When using this patch panel in combination with the E&M line board, and the keying inputs 
or outputs are used, a special Y-patch cable is required, Zenitel item no: 4000018472.

The black RJ-45 jack is connected to the E&M port on the Phontech 6200 unit, the red RJ-45 jack is 
the audio line and the yellow RJ-45 jack is the key IO. The red and yellow jack is inserted in the 6205 
patch panel at the desired locations. 
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8.5 PHONTECH 6216 EMERGENCY PA UNIT 

Key Features 

• Noise cancelling / Close talk gooseneck microphone

• Emergency PA activation button

• Protection against unintended use: sliding cover

Dimensions: 
144 x 96 x 83 mm (LxWxD 
Microphone height: 360 mm
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